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1. Presentation of the interface

1.1. Main window of the Fault Tree module

The main window is divided into several parts:

 Titlebar: Thetitle bar shows the names of the module and file being edited.

* Menu bar: The menu bar gives access to all the application's functions.

* lcon bar (shortcuts): The shortcut bar isan icon bar (horizontal) which givesfaster accessto the most common
functions.

e Tool bar: Thetool bar (vertical) allows you to select the elements for modeling.

* Input zone: A maximum amount of space has been left for the graphical input zone for creating the model.

» Tree: A treeis"hiden" between input zone and tool bar. It enables to walk through pages and groups of the

document.

Set of tables: Tables are gathered in "hiden" tabs on the right.
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1.2. Description of the Menus

1. The File menu contains the standard commands used in this type of menu (open, close, save, print, etc.). The
properties (name, creation date, created by, description, version) can be accessed and modified by selecting
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Document properties. The Document statistics provide information on the model's complexity. It is aso
possible to access a certain number (configurable) of recently modified files.

Theicon bar just under the menus proposes shortcuts for most of the File commands:

File|
% New Cirl-N
&= Open ... Ctrl-O
&= == L @ save Ctrl-5
Save as ...
Close Ctrl-F4

~ & Page layout ...

~ & Print ... Ctl-F
Save in RTF file ...
Quit Chi-o

2. The Edit menu contains all the commands needed to edit the model being input graphically.

Theicon bar just under the menus proposes shortcuts for most of the Edit commands:

|
2 Undo ctil-z
2 Redo Chil+Maj-Z
— % Copy CHl-C
- 3 Cut Ctl-%,
y — [ Paste Gl
@ e I || e || I || ] || [?Fl || % | - I?‘pL Paste and renumber Cctl-R

\/' ﬁl Remove Supprimer
Owverall change ...

Selection change ...

Select all Cirl-2,
Properties AltEntrée

3. The Tools menu contains al the commands needed to manage the current model (page management,
alignments, options, etc.).

Theicon bar just under the menus proposes shortcuts for most of the Tools commands:

Tools |
7 New Page
Page manager ... | E‘ | '% | E‘ UF ’ﬂ ﬂJl
Move to page ...
‘% Refresh
Align ... M = aiigniett” /
Zoom $ Align center
=] Align right
T Align top
View toolsBar ¢ G Align middle
¥ Display state har [Ip Align bottom
Document options
Application options
Connect to a CSV file
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4. The Document menu gives access to all the documents being created or modified.

Document |

Hext
Previous

Ctrl-Fi&

Ctrl+h aj-Fi

¥ C:BusinesswJaGrif 4.08.0 RC1'TreeiTree1.jtr

5. The Fault Tree menu contains all the commands needed to produce the graphical part of the current model.

The vertical icon bar on the left of the application provides shortcuts for each of the Fault Tree commands

(cf. vertical tool bar).

Fault-Tree |

¥ Select

[ Gate "And"

O Gate "0Or"

1 Gate "K Out Of N"
[0 Gate "Comment"

[J Elermentany event

O Basic event

I To be developed event
[0’ Home event

[ Hegation

[J Link {onhy one)
[ Links (many)

[T Identical transfer gate
[0 Repeated event

O Comment
[ Dymamic display
[0 Charts

6. The Data and Computations menuisdivided into two parts. data management (creation and management of
the different parameters) and configuration/computation launch (computation time, desired computation, etc.)..

Data and Computations |

Edit Parameters

Update from database ...

Verify

Launch JAaralia ¥2
Launch Aralia W2
Launch JAaralia V4
Aralia V4 data
Launch Aralia W4
Moca data
Launch Moca 12

NB: The Verify function detects any errors in the model: data without values (equal to NaN), events having

the same name, €tc.

7. The Group menu concerns the input and management of submodels grouped into independent subassemblies.

User Manual
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Theicon bar just under the menus proposes shortcuts for two of the Group commands:

Group |

Group
Change name F2
Lingroup

™ ** Edit group

- % Quit group edition

8. Finally, the Help menu accesses the on-line Help, the Help topics and to "About".

1.3. Vertical toolbar

Each operating safety model has its own icons. All the graphical symbols for the fault trees are shown on the
vertical icon bar on the left of the datainput screen.

Fault-Tree
Select

%~ Gate "and”

- Gate "or"

M Gate "K Out OF N*
M7 Gate "Comment™

A Elementary event

Mo Basic event

M To be developed event
M Home event

pJe o[ 1] Dlo]=

Wi

™1 Negation

B Link (onky one)

{7 Links {(mamy)

¢ Identical transfer gate
»_| Repeated event

b | Comment

¥ Dymamic display

| Charts

ElEl 3

A

IS B

The vertical toolbar contains the following items:

» Select selects the desired elements.

« "AND" gate to add alogic gate of the type "AND" (represented by a flat-based geometrical figure).

» "Or" gate to add alogic gate of the type "OR" (represented by a curved-based geometrical figure).

» "K out of N" to add alogic gate of the type "K out of N" (represented by a geometrical figure with a double
flat base).

e "Comment" gate toinsert ablock (represented by arectangle) containing only comments in the model.
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» Elementary event represented by a diamond shape.

» Basic event represented by acircle.

» Tobedeveloped event represented by two diamond shapes, one inside the other.

» Home" event represented by a shape vaguely resembling a house.

* Negation represented by asmall circle.

e Link (oneonly) to create one connection (and only one) between an input (gate) and an output (gate or event).
» Links (many) to create connections between the inputs (gates) and the outputs (gates and events).
 ldentical transfer gate represented by atriangle.

» Repeated event represented by acircle.
» Comment to add text directly to the graphic.

» Dynamic display to display the value of amodel element.
» Chartsto draw charts representing computations on the model.

1.4. Data Editing Tables

1.4.1. Description of the Tables

To create or modify data (parameters, variables, etc.), tables are available in the Data and Computations menu
and in tabs at the right of the view. All the GRIF 2014 data tables operate in the same manner.

Parameters o= sl
T =g ¥
Domain MName =~ Value

Bool

CondToStart

Float

Lambda

Float

Iu

Location

The data editing table/pand is divided into 3 parts:

e Thetop part containing the buttons.
» The main part containing the data table.

 The bottom part indicating what the selected datais used for.

lE'ﬂ Savesthetablein atext file.

Dﬁ- Opensthetablein atext editor (that defined in the Options).

H Opens the column manager.
a When the display selection button is pressed, aclick in the table |eads to the selection in the input

area.

“F Displays the data filtering part.

E Multiple modifications made to all the selected data.

B Creates new data.

......

E Duplicate the selected data (ask a new name)
> Deletes the selected data (one or many).
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Enables datafiltering or not.

Filtrer

Defines the filter to be applied to the data.

Filtering allows you to display only what is necessary in a table. Several filtering criteria can be combined, as
shown below:

Creation of data Filter
Associate tests with: @ AND ) OR Add a criteria:
|Value |V| |greater than |'| |1 a
|Name |V| |contains |'| |a|
| 0K I Cancel | Help |

Select AND or OR to choose the type of association between each line (filter criterion). A line is a Boolean
expression divided into 3 parts:

1. thefirst isthe column on which the filter is used,;
2. the second is the comparator;
3. thethird is the value to which the data will be compared.

If the Boolean expression istrue, the data will be kept (displayed); otherwise the data will be masked. When the
filter is enabled its value is displayed between < and >.

The datain a column can be sorted by double clicking the header of this column. The first double click will sort
the data in ascending order (small triangle pointing upwards). The second double click on the same header will
sort the column in descending order (small triangle pointing downwards).

A table can contain many columns, some columns may be unnecessary in certain cases. The "linked to database"
column is unnecessary when no database is available. It is thus possible to choose the columns to be displayed
and their order. To do this, click right on atable header, or click the Columns Manager button, the following
window opens:

Columns manager

Select columns that have to be displayed and their order

[w|Mame

[v]walue

[ Linked ta +
[ |Dimension 4
I ]Last datahase

[] Desactivate data sorting (fastest)

| 0K I Cancel | Help |

You can choose the columns to be displayed by selecting (or deselecting) the corresponding check boxes. The
arrows on the right are used to move the columns up or down in the list to choose the order of the columns. The
Disable data sorting check box disables the data sorting. Thisimproves the application's performance with very
complex models.

To modify data, double click the box to be modified. When several lines are selected (using the CTRL or SHIFT

keys) changes can be made to all the selected data by using Multiple changes. A window then opens to allow
you to make these changes.
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Multiple changes
Multiple changes of Parameters
Field Walue
Mame
Walue
Linked to
Dimension COther
Last database
| 0K I Cancel | Help |

Items which cannot be modified are greyed. The white lines indicate that the selected data does not have the same
value for the field in question. A new value can be entered which will be taken into account for all the selected
data. The lines with no background colour indicate that all the selected data has the same value for this field (in
this example the selected datais al "Float"); they can be changed to give a new value to al the selected data.

The bottom table in the data table indicates which elements in the model use the selected data. The first column
of this table gives the name of these elements; the second indicates their location in the document (page, group).
Clicking on alinein this bottom table opens the page where the element is located and sel ects the element.

1.4.2. Table accessibility

As mentioned above, the tables can be accessed via the Data and Computations menu; in this case, each table
is displayed in a separate window.

To avoid having too many windows open, all the tables are grouped together in tabs on the right-hand side of the
application. This area can be hidden/displayed using the small arrows above the input zone.
[

3 & |2 @

; q:mparameters
TN
| Cirmer

il warme | value [Link.. | Dim...[Last...
ILarnbdat 1.5E-4 Other
SlLarmbdaz 4.0E-4 Cther
< |[Mu 0.0114 Other

A mame ] Localization ]

[«

omk |
317201 Q ToTAL

It is possible to choose the tables in this zone by right clicking on the tabs. A contextual menu appears, in which
the user can select the tables s’he wishes to display.

{( % Variables | ¥ Parameters | = Tant —n
M .7 Variables
N

¥ W= Parameters
Domain |  Name « | |[F] Tables
Float |Lambda "

Results

1.4.3. Data creation

The Parameter editor isusedto create"real” parameters. The following window is only used to choose the name
of the new parameter. Its value must be entered later directly in the parameter table.
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Yariable /Parameter creation

Hame |Lambda |

Domain |Fluat | - |

Value  0.001 v

| 0K I Cancel | Help |

1.5. Tree view

7 Filtre

3 MySystem
¢ ] Page 1
¢ Grpl
o= [ Sub-Grpl
o= ] Grp2
[ FPage 2
CH Page 3

To help users to walk through the document (pages, groups ans su.b-groups), atreeisavailable on the left of the
application. By default, every element is displayed, you can use Filter buttonin order to select elements you want
to display or not.

Y ou can expand or collapse a node in arecursive way with aright click on the node.

As explained for tables on the right, you can "hide" the tree.
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To enter the different Gates, sel ect the corresponding symbol on the vertical toolbar. A new element isthen created
whenever you click right on the graphical entry area. Each of the model's gates has five parameters:

1. A number: These numbers are, with the type, the gates true identifiers (those which will be used by the
computation engine). That is why, when you wish to change the numbers of certain gates, you must remember
that two gates cannot have an identical number. They are automatically incremented as new elements are
created.

2. A name: It isaparameter which is defined automatically and which cannot be modified by the user. The name
of each gate consists of its "type" followed by its "number" (e.g.: "And1" or "KofN3").

3. A"K out of N" integer: Thisfield isonly accessible in the case of K out of N gates. It allows you to choose
the value of K (K equals 1 by default).

4. A comment: This field adds text inside the gate. This function makes the model more legible (by giving the
specific features of these elements).

5. A type: When a gate has been created, its type can be modified to one of the five types available in the drop-
down list.

+«— Comment

Comment 1
@ wit «—— Name

Comment 2

" ﬁm

14|B (DD

Comment 2

Comment 4

‘ Rk

To enter the model's Events, select the corresponding symbol on the vertical toolbar. A new element isthen created
whenever you click left on the graphical entry area. Each of the model's events has five parameters:

1. A number: These numbersare, withthetype, the events trueidentifiers (those used by the computation engine).
That is why, when you wish to modify the numbers of certain events, you must remember that two events
cannot have an identical number. They are automatically incremented as new elements are created.

2. A name: The default name assigned to the eventsis Evti for the"i" the element created. Y ou are recommended
to replace this name by something more mnemonic to increase the model's legibility.

3. A comment: Thisfield adds text inside the event. This function increases the model's legibility (by giving the
specific features of these elements).
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4. A law: Thiselement is used to model the event's random aspect. Y ou can choose from many laws which must
then be configured (cf. detailed description of the laws later on in this document).

5. A type: When an event has been created, its type can be modified from the four types available in the drop-
down list.

«—— Comment

Comment vt 1

<> ——— Number

e 4+——— Name

exponential 1E-3

T

— Law

Comment evt 2

o

Ewtl
exponential 162

D¢ |0|C

Comment vt 3

©

Evt3
exponential 1E-3

Comment evt 4

()

Ewtd
exponential 162

For each gate or event, you can set it initiator (with aright clik). This attribut must be seen from an "Event-Tree"
point of view. In an event-tree an initiator is an event that must happen befo barriers set the system in a safe mode.
In order to have a Top-event, iniator event must happen after barriersfailure. Setting initiator attribut on and event
means that it must appear after the "non-initiator" events. This setting has an impact on UFI computation only.
There is no impact on Probability of Equivalent lambda.

When the gates and events have been created, they must be interconnected to establish the tree's logic. There are
two possible types of connections. "gate -> gate" and "gate -> event" connections. To make a connection, proceed
asfollows:

1. Click the corresponding icon on the vertical toolbar.

2. Select the start gate by a click left on the specific zone (a dot for "AND" gates, a cross for "OR" gates, €etc.)
and keep the button pressed.

3. Move the mouse to the element to be connected.
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4. Release the mouse button.

Commert 1

@Pﬂdl
>

Comment evt 1

%

Ewt1
exponential 162

NB: Theaboveicon only allowsasinglelink to becreated at atime. If youwish to create several linksin succession
without having to reselect the link creation icon each time, use the icon shown below: Links (several).

'_LI

2.1.5. NOT gate
Itisavery specific gate which inverts the logic of the subtree which is downstream of it.
Toinsert a"Negation" in atree, proceed as follows:

« changethe type of an existing gate by using the drop down list;
» OR create anew anew gate with the type "Negation™:
1. Click left on the corresponding icon on the vertical toolbar.
2. A new element will then be created whenever you click |eft on the graphical entry area.
3. Youthenjust have to configure and connect the "Negation” like a conventional gate: link the top part (above
the circle) to the bottom part of a gate and link the bottom part (below the circle) to the top part of an event
or gate.

o} s #} Hegl

2.1.6. Entering Comments

To add acomment anywhere on the chart, click the pencil icon and place yourself on apoint in the graphical input
zone. The Comment dialogue box opens where you can enter the desired comment.

Note: Character "%" is areserved character, it must be type twice "%%" in order to display "%".

8 Comment E3

Mevy system

i N
[New systerm,

— :

l/’j-\l J/fl\\tn s ,’/:-‘\l mKoﬂ-
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2.1.7. Dynamic fields

It may be useful to observe the change in the different parameters of the model. It is also usefull to see a result
next to its corresponding system. To do this, use dynamic fields by selecting the corresponding icon on the vertical
tool bar:

The dynamic fields are a type of "improved comments'. They can be used not only to enter words or phrases but
also to insert model values or results.

$data.parameter.name(Lambda).value

0K | Annuler Aide

If you want to display informations about a data of the model, you must use the following syntax:

$data.'type of data.'field used o search data('value that the field must match).'information you want to display
for the selected data

We can analyze the above windows as follows: | am looking for a "parameter" which "name" is 'lambda’, and |
want to display its"value". When you type the first letters, a completion system helpsto type script without error.

If you want to display aresult of the result-bank, the syntax is the following:
$result.bank('path in the bank').target('target result’).'what you want to display'.'at what time'

We can analyze the next picture as follows: | am looking for aresult which path in the bank is "default-Moca’, |
want resultsfor "TS3 for ‘available valriable" and | want itsvaluefor the"last” time. If last is replaced by time(10)
we obtain value at t=10.

Etommentaire

Sresult.bank(/default-Moca).target(variable/STAT_TYPE3/availability) value last

[
! |
Iooas |
| |
===

0K | Annuler Aide |
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Y ou can a so display asummary of result. Replace ‘what you want to display' by summary. In thiscase, summary
isthe last word of this script.

A button has been added in 2013 version, it is a script generator for model data.

2.2. Configuring the elements

All the graphical elements can normally be edited with a double-click on them or using the Edit - Properties
menu, or using the shortcut Alt + Enter.

2.2.1. Configuring the gates

When you click right on agate, you can modify any parameter (except the name):

=4 Properties E

T

| ok | cacl o |

 changethe number;
» gpecify thevalue of K if thegateisa"K out of N" type;
* read and/or modify the comment part;

» modify the type of gate to one of the five types available in the drop-down list:
e "OR" gate: an "OR" type logic gate is applied to the elements connected downstream.
* "AND" gate: an "AND" type logic is applied to the elements connected downstream.
o "Kof N": a"K of N" typelogic is applied to the elements connected upstream.

e "Comment" gate: this gate has no effect from the logic viewpoint and is only used to comment on the branch
whereit islocated.

* "NOT" gate: cf. above.
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2.2.2. Configuring the events

When you click right on agate, you can modify any parameter (except the name):

= Properties

* to change the number;

* to enter the event name;

* toread and/or modify the comment part;

* toread and/or modify the law gover ning the event.

+ to modify the type to one of the four available typesin the drop-down list:
« Elementary event;
» Basic event;
* To be developed event;
» "Home" event.

The names of these events simply have a "graphical" impact on the tree structure. There is no impact on the
logic function which will be generated to perform the computations. The aim is simply to simplify re(reading)
the fault tree

Thelaw part is configured in several steps:

1. Choose the law from the twenty-three available in the drop-down list.
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2. Configure the law (adrop-down list of the modul€e's parametersis available for each field to befilled in).

3. Uncertainty computations can be introduced for each of the parameters, with a choice of the law and of the
corresponding parameters (cf. later on in this document: a detailed description of the uncertainty computations
on the parameters).

=2 Law choice

2.3. Using shortcuts

2.3.1. Identical Transfer Gates (or Shortcuts on gates)

The concept of ashortcut (or repeated element) was introduced in the Fault Tree module for four main reasons:

To link together portions of the model;

» Toavoid graphicaly complex model, and keep readability;
* To simplify the use of the Group function (cf. below);

To highlight what is essential and what is not.
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Let afault tree contain three base events, one "OR" gate (critical event) and one "AND" gate.

ER

C‘ié ar

LS SEMSORS
0, s
Eut1
| |
Sensar 1 fails Sensar 2 fails
Ewtl Evtd

The aim here is to create a shortcut to the gate (identical trasfert gate) called "And2" to be able to dissociate the
"And2" subtree from the main tree. Proceed as follows:

1. Delete the existing link between gate "Or1" and gate "And2".

2. Click left on the Transfert Gate of tool-bar then click on "And2" Gate.

SEMSORS

Aadi
Page 11

L — [ |

Senzor 1 failz Senszor 2 failz
Ewt2 Ewt3
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3. Connect the shortcut created in this manner to gate "Or1".

ER

C‘ié ar
SEMSORS

[
LS
- Name of the gate of origin
O A
Page 1 -
Euvt1

— Page number of the gate of origin

Sensar 1 fails Sensar 2 fails

Q 0

Ewtl Ewt3

The name of the original gate and the page number where the original gate islocated are shown beside the shortcut
to gate "And2".

Although linked from the "computational logic" viewpoint, the two trees are now totally graphically independent.
They can now be placed on different pages or in different groups (cf. later on in this document).

2.3.2. Repeated events (or Shortcuts on events)

From the logic viewpoint an event can have an "impact” on several "branches" of the same tree. To correctly
model this case, this event must be duplicated. To do this, select the corresponding icon on the vertical toolbar,
then click the event to be duplicated:

~ Name of the event of origin

The event which has just been duplicated is now marked in dark grey whereas the duplicated event is shown in
light grey. The name and number of the original event's page are shown beside the shortcut.

The repeated event must now be inserted in the model, given that at each instant its state will be equal to that
of the original event.

NB: Obvioudly, if the original event is deleted then the duplicated event is a so deleted.

2.4. Page and group management

The use of shortcuts alowed us to obtain two Fault Tree which have no graphical link between them. They
communicate only by shortcuts. This can be used, for example, to place each subpart on adifferent page:

1. Create anew page by clicking the corresponding icon in theicon bar (or use menu Tools - New Page). A page
number 2 is thus created.
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2. Return to page 1 by selecting the page using the page selector in the ideographic command bar (or use menu
Tools - Page manager).

3. Select the part to be moved.

4. Open menu Tools - Change page.

5. Select page 2 and click OK. The part selected is transferred to page 2 but it continues to communicate with
page 1 viathe shortcuts.

Note: For large models the division method described aboveis very useful.

Another possibility for entering large Fault Tree is to use the Group concept. This is made possible by the
shortcuts and the fact that the datais global for a document. This allows quite separate subparts to be created:

1. Select a subpart.

2. Use menu Group - Group. A dialogue box then opens asking for the name to be given to the group being
created.

3. Enter the desired name and click OK (e.g.: "System 1"). The group is created: the subnet is replaced by a
rectangle assigned with the chosen name.

Y ou can a'so create an empty group with Group - New Group menu or group tool in the left toolbar.

Group

Group

b S ¢

Each group can then be edited, renamed or ungrouped using the commands in the Group menu. The group can
also be edited with a click right or using the "cursor down arrow™ on the left of the page manager. In Edit mode,
the submodel can then be modified as you wish. When the modification is terminated you return to the previous
figure by exiting group editing by menu Group - Quit Group Edition, or using the "cursor up arrow" on the left
of the page manager. It's also possible to choose a picture for a group by using Group - Change Picture menu.

Note: Groups can be grouped recursively.

2.5. Data Entry Aids

To simplify model creation the Fault Tree module has different data entry aids to automate time-consuming
operations.

2.5.1. Copy / Paste / Renumber (without shortcut)

To assist with the entry of the repeated parts of the Fault Tree "Copy / Paste and Renumber" mechanisms have
been provided. This operation is carried out in 6 steps:

1. Select the part to be copied.
2. Click the Copy icon, or use menu Edit - Copy or the shortcut Ctrl + C.
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3. Click the Paste and Renumber icon, or use menu Edit - Paste and Renumber or the shortcut Ctrl + R.
4. A window appears where you choose the start number for the renumbering.
5. The previously selected part is copied and the copy is selected.
6. Move the copy to the desired location.

We then obtain the tree shown in the figure below:

* Or1and And2 gates from original tree are become Or3 and And4 for the copy;
» Evtl, Evt2 and Evt3 events from original tree are become Evt4, Evt5 and Evt6 for the copy.

SENSORE

@m

N

Senzor 1 failz

Senszor 2 failz

o

&)

=)

2/

~

! Sensor 1 fails

When copying to a new document, any data conflicts are handled in the following window:

Some data has same name in destination document.

Data conflict

Please manage conflictin order to "paste”.

(@) Use data of destination document.

) Create a copy for each data in conflict.

) Manually manage conflict:

Source document Destination document Use existing
Lambda2 v]
Lambda+ v]

Mu v]
0K I Cancel Help

This window shows all the data which has the same name in the source document and the destination document.

There are three choices:

1. Use data of destination document, this will replace the occurrences of the data in the source document by the
datawith the same name in the destination document.
2. Create a copy for each datain conflict, thiswill replace the occurrences of the data in the source document by
acopy with a name with the suffix "copy".
3. Manually manage conflict, this allows you to choose whether you use the existing data or not, depending on the
data. Y ou can aso specify the name of the copy by double clicking on the box in the "destination document"
column. The names in this column are normally masked when the Use existing check box is selected, since it
isthe datawhich is already in the destination document which will be used.
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2.5.2. Copy / Paste / Renumber (with shortcut)

The"Copy / Paste and Renumber" command creates new "instances' i.e. new subtree similar to the subtree copied:
» Same graphical structure;

e Same parameters,

» The number and name of the events and gates change (new name: Evti for events and " type of gate"i for the
gates, wherei isthe new number).

e Same comments.
When identical transfer gates are part of the selection to be Copied / Pasted and Renumbered, they will then remain

unchanged for the copy. They shall always point to the same gate if this gate is not part included in the selection
to be copied.

4 - N O T

|
|
|
|
or1 1 or3
TR = N .

| N N 1

SENSORS

& NCAVES

i
N

In the above example, gate Or 1 an event Evt1 have been renumbered normally. The shortcut to gate And2 has
not been modified.

When a gate that part of a shortcut is also part of aselection hat is going to be "Copied /Pasted and Renumbered"”
and if the shortcut itself is not present, then the gate will be renumbered in the conventional manner.

4 N T ] )

| | >, .

Sensar 1 fails Sensar 2 fails

\@ Q/ k---w----; .E\nﬁ/

In the above example, all of the events and gates have been renumbered normally.

When identical transfer gate (and their corresponding origina gate) are included in the selection to be "Copied /
Pasted and Renumbered”, then new shortcuts will be created and they will be linked to the new gates.
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In the above example, the gate that islinked to ashortcut has been renumbered (And2 -> And4) and so its shortcut
has al so been modified.

Y ou can navigate between an element's different shortcuts, using menu Tools/Navigate to shortcuts. A window
opens and displays the list of shortcuts. Clicking on a shortcut automatically positions the view on this shortcut.
Y ou can return to the original element by clicking on its name at the top of the window.

2.5.3. Ordinary Copy/Paste

In addition to the "Copy / Paste and Renumber" command there is an ordinary "Copy / Paste” function. It is used
to make a single copy without renumbering. We thus obtain double elements which, from aformal viewpoint, is
incorrect but which must be temporarily tolerated to simplify data entry.

Where possible, the " Copy / Paste and Renumber" function must be used in preferenceto the simple " Copy / Paste”
function to minimise the risk of errors. But when it is used you must take the necessary precautionsto re-establish
the correct numbering to eliminate the duplicates.

2.5.4. Overall change

When creating the Fault Tree it may be necessary to change alarge part of the elements in the models. changing
the names, numbers, etc. The "Replace al" function in the Edit menu allows you to perform overall changes:

» Usethe Edit / Overall changes function.
» Choose the type of elementsto be modified among available tabs.

* The "Find / Replace" part changes a character string present in one or more variable labels, place labels or
transition labels. It is replaced by the string entered in the "Replace” part.

» The"Renumber" part only concernsthe places. It isused to change place numbers. Y ou indicate a Start number
then specify a constant Step, or Add a constant val ue to the current numbers.

» Click OK to return to the chart. The changes are validated.

Note: The name changes and renumbering can be done manually if the necessary precautions are taken (avoiding
duplicates, etc.). You click the Future number or Future name column and enter the change. Do not forget to
validate it with the "ENTER" key.
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EGR]F - Fault-Tree Module

Gates | Events |

Present number Present name Future number Future name
1(Evtl 1|Ewt1
2(Bvt2 2|Ewt2
3[Evt3 3|Ewt3
Renumber
Begin 100 Step 1 | Renumber | | Renumber all |
Add 10 | Renumber | | Renumber all |
Find/Replace/?
Find | | [ ] Regular expression
Replace by | | | Replace ‘ | Replace all ‘
| 0K I Cancel | Help |

2.5.5. Selection change

The "Replace selection" function is equivalent to a"Replace all" but only applied to the selected elements. Only

the selected gates and events can be replaced.

NB: The "Replace selection” function does not allow the model's parameters to be replaced.

2.5.6. Document properties / Images management

File - Doucument properties menu enable to save information about document : name, version, comment, ...

These informations are available in General tab.
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Document properties E

rGeneraI rlmages |

File : Cillsersicfolleautworks pace\GRIFEruniEFiab\ElocFiabZ jbad

Name : |System K1E4

Version : |‘1 3

Author: |cfo||eau

|
|
PID:  |v123R4 |
|
|

Date:  |15July 2011

Comment

Images may bevery useful to represent sub-system. GRIF 2014 enablesto save imagesthat can be used in different
parts of software (groupes, prototypes, ...). Images management is made in | mages tab.

General | Images |

Description File
hdd.jpg hdd jpg
power-supply.jpg power-supply.jpg
power.jpg pOWEr.jpg
NAS.jpa MAS.jpg

| 0K I Cancel Help

-1

To add anew pictureinto document, use L% icon. A doubleclick in File column enablesto select an picture (jpg,
gif or png). A double click in Description column enables to give a name or a description to selected image.

Once in document, picture can be linked to a groupe with Group - Pictur e change menu.

Images are saved indide document, pay attention to picture size. Because images are inside document, you have
to re-add pictureif picture is modified erternaly.
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To improve the legibility of the model the selected elements can be aligned vertically or horizontally. To do this,
use the Align command in the Tools menu.

The following figure shows how the command works. For example, to align selected places and transitions
vertically, proceed asfollows:

1. Select the elements (places, transitions, comments, etc.) to be aligned;
2. Gointo the Tools menu and select the Align function;
3. Choose the type of alignment: Align center;

4. Click left on the mouse.

T : Tools | 5""""' :
! | ‘1 New Page ! \
i @ e i Page manager ... | @ e i
oo __ . Move to page ... o= .
- . '@? Refresh . — e oo .
.Comment, Align . » = align lert Commen,
Zoom $ Align center
| — ==} Align right -  — :
! E [T Align top | !
: @ ! View toolsBar ¥ & Align middle ! @ !
! ! ¥ Display state bar [n Align bottom ! :
L — Document options L
Application options
Connect to a CSV file

Similarly, to align elements horizontally select the type Align middle which aligns the ordinates while keeping
the abscissa constant. The principle isthe same as that described above.

It may sometimes be useful to select several elements located in the four corners of the input zone. To simplify
this type of selection click on each of the desired elements one by one while holding down the Shift key on the
keyboard.

It is sometimes difficult to select an additional part of amodel. To simplify the selection process, select agraphical
element then use menu Select connex part in the Edit menu. The additional part can be selected directly by
clicking on the element while keeping the Control button pressed.

When creating a model, if the page size is not big enough, it can be changed using the menus : I ncrease page
size (Control+Keypad +), Reduce page size (Control+Keypad -), Page size (Control+Keypad /) under the
Tools menu.

The Page size menu allows the user to edit the page dimensions directly.
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(a4 Size and page zoom (==
Width @u px

Height @ px

Zoom Normal ﬂ

[] Apply on all document pages

Default values H OK H Cancel H Help |

Page zooms can be modified either by using the toolbar menu:

Normal| | + || g
133% I
66%
5%
Normal
150%
175%
200%

Or by selecting the display and using Control+mouse wheel scroll up to zoom or Control+mouse wheel scroll
down to zoom out.

The padlock on the toolbar is used to apply the zoom to the current page or to all pagesin the document.

’The zoom appliesto al pagesin the document.

o ‘ The zoom is applied only to the current page.

Note that if an element is selected on the page, the zoom will centre the page on that element.

2.5.11. Cross hair

To beableto create an ordered and legible model quickly, thecrosshair can be used to align the different elements
with each other (but less accurately than the Align function in the Tools menu). The cross hair is enabled (or
disabled) in the Graphics tab of the Option menu.

The following picture show how to quickly align two element of the model.

In order to align horizontally, select Align au middle which align keeping constant abscissa.

2.5.12. Gluing/Associating graphics

When objects are where you want, you can glue aset of object by right-clicking and selecting Glue. Thiscommand
create agroup (agraphical one, not ahierarchical one) with selected objects, so that moving one movesthe others.

2.5.13. Line

To be able to draw a line, polyline or arrow, the Line can be used. Draw the line and edit properties of line to
make an arrow.
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Font setup

Lines setup

Width IZIE
=

Color

[ ] Arrow begin Arrow end

Arrow width
Arrow height

Preview

OK I Cancel

Help |

2.5.14. Table Cleaning

Data may not be used anymore, it can be used usefull to delete every unused data. To facilitate removal, use Data

and Computations/ Unused data deletion menu.

Unused data deletion [ %]

Following data are not used in model:

Parameters
Lamhdal
Lambda2
hu

| Select all | | Unselect all |

Select data you want to delete and click OK.

[ ok | cancel | Hew |

Thiswindow displays unused data. Select data you realy yan to delete and click OK.
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3. Help with common cause failures

Tofacilitate the creation of model, the Fault Tree module allowsthe creation of CCF(Common Cause Failure), and
tolink alogica entity(Event, Block) to one or more common cause failures. CCF are available in the data table.
Thereisno graphical entity associated with CCF. Thelogical entity associated with an active CCF are graphically
marked by ayellow flash :

g [og——
‘k,s" ,J@f
H f
b 5
-/3 3 /1
e s
Evid Ewti
eoporenial 1E-3 eoperenial 1E-3
Ofiai O il
Oy} =7 Qg =7
ocd - CCF1 ot - COF1

3.1. Creating a CCF

The creation of anew CCF is possible in different ways :

1. click Add button on table data,
2. Use the contextual menu on logical entities: CCF - Add new CCF

#
ij= 7

*| wn Couper
= Copier

15

e

iR

Y B 7 Lt )

v & X

I Supprimer Supprimer

[t Association
Position

-f- Aligner

{' Aligner et répartir

- w w w

& CCF | Attacher a une nouvelle CCF

Attacher a une CCF existante | PR e

Ajouter a la liste des éléments observés

EEH Modification multiple Détacher les CCF

3.2. Editing a CCF

Y ou can edit the properties of a CCF in different ways:

1. Double-Click on acell of the CCF table, and edit.
2. Use the contextual menu on atable raw and click on Property action
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Défaillances de causes communes |
Paramétres |/ Evénements |/ Portes |/ Banque de résultats |

E] (] [ b [l A
« | nom [mut.| commentaire | Aci] Lol [ |
1 CCE1 | B P P P i ]

t Enregitrer le tableau complet {txt)

' Enregitrer le tableau filtré {txt)
Editer

Gestionnaire des colonnes

" Filtrer

4 Ajouter
Dupliquer

¥ Supprimer
Propriétés AltEntrée

H

A configuration window opens:

-
[l ropricits m

Huméro 1

Nom ( [v] Automatique } CCF1
Commentaire

Eléments impactés

[5e | .x
D MNam
3 Evt3
1 Evt1

Loi de la défaillance de cause commune

Loi Beta-Total J:

Paramétre{s)
Beta {Beta) |0.5 |
OR | A | Akl ‘

|

Two types of laws are now possible for a CCF:

1. The beta-total law : Beta parameter is applied to the laws of concerned components. Singularities :
a. A component can be concerned by several CCF using beta-total law.
b. The sum of the beta set on the CCF must be strictly less than 1 for a component.
¢. The supported laws for a component are exponential, constant and test-periodic.
2. The beta-nuclear law : The laws of the components are replaced by the law defined by the CCF. Singularities:
a. A component must be linked to only one CCF using beta-nuclear law.
b. Laws of components are no longer used.
¢. The supported laws for CCF are exponential, constant and periodic-test.
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4. Laws and uncertainties

4.1. Description of the laws

A total of twenty-three laws are available in the Fault Tree module. Each of these laws has one or more
corresponding parameters. Hereisalist of the different "types’ possible:

» Probahility: value between 0 and 1 inclusive.

» Rate: value greater than or equal to corresponding to afailure rate.

 Duration: value greater than or equal to 0 corresponding to aduration or to atime.
* Factor: value strictly greater than O.

* Natlnt: integer value greater than or equal to 0.

» Boolean: can take avalue of 0 or 1 corresponding to an option parameter.

* Other: any value.

In the remainder of this chapter, the parameter "types’ will be specified for each law.

4.1.1. ALD/On-demand law (for Albizia: constant law)

Thislaw hastwo parameters: the probability g and theinconditional failureratew of the event. Whatever thetime,
the probability of the component failing is constant.

Parameter:

* ( (Probability)
» w (Inconditional failure rate)

The law is defined as follows:

Q=4

Thislaw generally correspondsto the case where the only failure considered for the componentsisthat of arefusal
to change state (e.g.: Failsto start/stop, etc.).

4.1.2. EXP / Exponential law

Thislaw only has a one parameter: the component's failure rate (supposed to be constant over time). It describes
the timeinterval before the first failure for a non-repairable component.

Parameters:
* Lambda (Rate) = failure rate

The law is defined as follows:
On=1-e"

Thislaw iswidely used sinceit isamost the only one to make it possible to obtain analytical results. In addition,
it describes the lifetime of a non-repairable component very well (at least when there are a large number of
components) when the component is no longer young.

4.1.3. IND / Unavailability law (for Albizia: GLM)

This law describes the behaviour of a component (repairable or not), with (or without) failure to start, using
exponential expressions. It generalises the exponential law with the L ambda parameter (failure rate).
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Parameters:

» Gamma (Probability) = probability of initia start failure (at t = Q)
* Lambda (Rate) = falurerate
* Mu (Rate) = repair rate

The law is defined as follows:

] A A=0(A+ 1) _(,
{_)(f)= - _ A( { )X(Z (A+ 20}t
A+ A+ 1t

The Gamma and Mu parameters are optional. Depending on the case, they can be zero.

* If the component is not repairable, set Mu to zero.
* If the component cannot fail to start, set Gamma to zero.

NB: Thefailureto start is only taken into account at t = 0.

Thislaw hasthree parameters: alpha, beta and t0. It describesthe behaviour of acomponent whichisnot repairable
and which doesnot fail to start. Itsspecific featureisthat it takes account of the component'syoung and old periods.

Parameters:

» Alpha (Factor) = scale parameter
» Beta Factor) = form parameter
* TO (Time) = location parameter

Thelaw is defined as follows:

i
] r—t
O@t)y=1-exp —( 0 J
o

The significance of thislaw is that new distributions can be tested by varying the beta factor:

 If Betaislessthan 1, the failure rate decreases and the law then allows the period when the component is young
to be taken into account.

 If Betais greater than 1, the failure rate increases and the law then allows the component's ageing period to
be taken into account.

» If Betaiseqgual to 1, the Weibull law is equivalent to the exponential law.

Thislaw allows acomponent which failsto be represented according to an exponential distribution law and whose
failure isfound during a periodic test. The repair is then carried out instantaneously.

Parameters:

* Lambda (Rate) = failure rate
» Tau (Duration) = test period (time interval between two consecutive tests)
e TO(Time) = date of first test

Thelaw is defined as follows:

e i <t

) 0
{_)(f) - e,‘{‘g_tu mmdt’]

otherwise
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Hereisasmall graph representing the different phases of the component's "life":

TEST TEST TEST
t=0 To t=TO0 Tau t=Tau +TO Tau t=2Tau + TO
operation operation operation
(law exp(A))

NB: Thislaw isasimplified version of the"TPC / Full Periodic Test" law.

4.1.6. TPE /| Extended Periodic Test law

Thislaw allows acomponent which fail sto be represented according to an exponential distribution law and whose
failureis found during a periodic test. The repair phase is then modelled by an exponentia of the Mu parameter.

Parameters:

Lambda (Rate) = failure rate

Mu (Rate) = repair rate (when the failure has been found during atest)
Tau (Duration) = test period (time interval between two consecutive tests)
TO (Time) = date of first test

Hereisasmall graph representing the different phases of the component's "life":

TEST TEST TEST
t=0 To t=Ti Tau =Tau+TO0 Tau t=2Tau + TO

operation operation operation
(law exp(A)) \ \
repair repair
(law exp(p))

NB: Thislaw isasimplified version of the"TPC / Full Periodic Test" law.

4.1.7. TPC/ Full Periodic Test law

This law allows a periodically tested component to be represented as completely as possible. There are many
parametersin play.

Parameters:

» Lambda (Rate) = failure rate during operation or on standby

» Lambda* (Rate) = failure rate during the test

* Mu (Rate) = repair rate (once the test has shown up the failure)

» Tau (Duration) = test period (time interval between two consecutive tests)

» Teta (Time) = date of first test (ignore parameter value: Tau)

* Gamma (Probability) = probability of failure due to starting the test (ignore parameter value: 0 = starting the
test does not cause afailure)

» Pi (Duration) = duration of test (ignore parameter value: O (instantaneous test))

» X = (Boolean) indicator of component availability during the test (O = component unavailable during the test;
1 = component available) (ignore parameter value: 1 = available during the test)

» Sigma (Probability) = test cover rate (probability that the component failure is detected during the test) (ignore
parameter value: 1 = the test covers all the possible failures)

» Omega 1 ((Probability) = probahility of forgetting to reconfigure after the test (ignore parameter value: 0 =
no reconfiguration problem)

» Omega 2 ((Probability) = probability of forgetting to reconfigure after the repairing (ignore parameter value:
0 = no reconfiguration problem)
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NB : the"ignore parameter value" isthevalueto typeif you want parameter to do not affect component avail ability.

Hereisasmall graph representing the different phases of the component's "life":

TEST TEST
t=T0 t=T0+m t=Tau+T0 t=Tau+T0+

operation operation operation
(law exp(A)) \ \
repair repair
(law exp(p))

4.1.8. NRD / No Recovery Before Delay law

This law takes two parameters: arepair rate Mu and a delay Delay. For non repairable components, it gives the
probability of not succeeding to recover the component before adelay Delay.

NB: Thislaw does not depend on the time, it is a short version of a constant law.
Parameters:

e Mu (Rate) = repair rate
 d (Duration) = recovery time

The law is defined as follows:
O(y=e™

4.1.9. GLM / GLM Asymptotic law (for Albizia: asymptotic exponential law)

This law is a variation of the "IND / Unavailability" law. It corresponds to the probability of a "IND /
Unavailability" law computed at t = infinity.

NB: Thislaw does not depend on the time, it is a short version of a constant law.
Parameters:

* Lambda (Rate) = falurerate
e Mu (Rate) = repair rate

The law is defined as follows:

bl

oy ="

A+ 1

4.1.10. DOR / Dormant

This law has three parameters. a failure rate, a mean repair time and a delay. In addition, it does not depend on
the time.

Parameters:

» Lambda (Rate) = failure rate
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* MTTR (Duration) = average repair time
» d (Duration) = delay

Thelaw is defined as follows:

_Jd -7t
Jd—(1—e YWAMITR(l-e )
Ad

Ad+AMTTR.(1—e )

o) =

Thislaw isa simplified case of the "IND / Unavailability" law. It corresponds to an exponential law with afixed
time given as parameter.

Notel: Thislaw does not depend on the time, it is a short version of a constant law.
Note2: The parameter Q is optional.

Parameters:

* Lambda (Rate) = failurerate

* T (Duration) = mission time

* Q (Probability) = optional law

The law is defined as follows:

AT

O = O+l-¢

This not actually en law, you must enter probability and failure rate in a tableau according to the time.

NB: If you ask for computation a times that are not in the table, the value will be interpolated according to other
points.

Thislaw usesaMarkov graph asdefinition. Select the path of the .jmafile. In order to do Boolean computation, you
need to do apreprocessing of thelaw. The preprocessing automatically start Markov modul e and retrieve necessary
values. It can be done with aright-click on the object having the law, or in Data and computations menu.

This law has two parameters: and upper limit and a lower limit.
Parameters:

* a=upper limit
* b =lower limit

Thelaw is defined as follows:

(t—a)

Q) = (b—a)
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4.1.15. NLOG / Log normal law
This law has two parameters: the mean and the standard deviation.
Parameters:

e Mu=mean
» Sigma = standard deviation

Thelaw is defined as follows:

¢ 1 _"ﬁ (nt—p2)* |
. . ~ 252
o =1=[fndt  fi=—"=e 7~
0 to~N2m
4.1.16. NORM / Normale
Thislaw has two parameters: the mean and the standard deviation.
Parameters:
* Mu = mean
» Sigma = standard deviation
Thelaw is defined as follows:
(=" )
l _. 26° }.‘

e "

t
(1) = 1=| fAndr F(n=
! (=
4.2. Uncertainties on the parameters

For each probability law used in the model, it is possible to introduce an uncertainty on each of the parameters.
There are three laws available to model them:

e "NLOG/ Lognorma" law;
e "UNIF/ Uniform" law;
* "NORM / Normal" |aw.

NB: Each of these laws is described in the previous subchapter.

Using this method, it is thus possible to introduce the impact of the uncertainties on the data into the final result.
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5. Example of a Fault Tree

Here is a fault tree modeling the behaviour of any safety system with two possible states: "work" / "failed" (or
"available" / "unavailable"). The aim is thus to construct a tree allowing us to evauate the system's mean
unavailability.

ER
or1
Logice Wit WES Relay SENSORS Sub-systems
KofMN3
LS R
exponential Lambdal Gl D 1E4 hiadl |
wlve 1 Senzorl Sub-system 1

B3y

o

51

o

51

perodic-test LambdaZ Test 0 GLhd Gamma Lambdal hduZ perodic-test LambdaZ Lambdal sl 4.32E3 4.32E3 01001 0

“wahre 2 Sensor 2

Sub-system 2
Sh2 52 552

perodic-test LambdaZ Test 10 GLhd Gamma Lambdal bl periodic-test Lambda2 Lambdal bl 4 32E2 10010010

Senzor 3

o

GLh Gamma Lambdal hduz

=Y Edit Parameters [ [O0]

Gamma

Lamhdal 1.2E-5
LamhdaZ2 49.0E-5
hfut 0.0414
hiuz 0.0

Test

The above tree has nine events:

LS
e Number: 1
¢ Comment: "Logic"
e Law: exponential law with "Lambda" = Lambdal.
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e SV1
¢ Number: 2
¢ Comment: "Vave 1"

& ToTAL

* Law: simpleperiodic test law with "Lambda' = Lambda2, "Tau" = Test and "T0" = 0.

e SV2
¢ Number: 3
¢« Comment: "Vave 2"

e Law: simpleperiodic test law with "Lambda' = Lambda2, "Tau" = Test and "T0" = 10.

e S1
¢ Number: 4
¢ Comment: "Sensor 1"

e Law: unavailability with "Gamma' = Gamma, "Lambda’ = Lambdal and "Mu" = Mu2.

e 32
¢ Number: 5
e Comment: "Sensor 2"

¢ Law: unavailability with "Gamma' = Gammea, "Lambda"’ = Lambdal and "Mu" = Mu2.

« S3
* Number: 6
¢ Comment: "Sensor 3"

e Law: unavailability with "Gamma' = Gamma, "Lambda’ = Lambdal and "Mu" = Mu2.

* R
e Number: 7
e Comment: "Relay"

» Law: unavailability with "Gamma" = 0, "Lambda’ = 10e-4 and "Mu" = Mul.

+ SS1
* Number: 8
e Comment: "Sub-system 1"

e Law: full periodic test law with "Lambda' = Lambdal, "Lambda*" = Lambdal, "Mu" = Mul, "Tau" =
4380, "Teta' = 4380, "Gamma' =0, "Pi" =10, "X" =0, "Sigma" = 1 and "Omega" = 0.

«+ SS2
e Number: 9
e Comment: "Sub-system 2"

e Law: full periodic test law with "Lambda' = Lambdal, "Lambda*" = Lambdal, "Mu" = Mul, "Tau" =
4380, "Teta' = 10, "Gamma' =0, "Pi" = 10, "X" =0, "Sigma"' = 1 and "Omega" = 0.

Thetree'slogic is governed by four gates:

e Divl
¢ Number: 1
¢ Name: Orl
¢ Comment: "ER"
e Type: "OR"
e Divl
* Number: 2
* Name: And2
e Comment: "VALVES'
e Type: "AND"
e Divl
¢ Number: 3
* Name: KofN3
¢ Comment: "SENSORS"

e Type: "K out of N"
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* Divl
e Number: 4
¢ Name: Or4
¢ Comment: "Sub-systems"
* Type: "OR"

In this example, different types of more or less simple laws have been used. It was produced in a short time and
allowed several more or less complex components to be modelled: non repairable, repairable, periodically-tested,
with probability of failure on demand, etc.

Using thistree, we can now run various computations on the different gates or events: unavailability computations,
unreliability computations, etc.
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6. Printing

For printing, you have several commands at your disposal in the File menu File:

» The Page setup function function allows you to choose the page orientation, the size of the margins, etc.
Mise en page ﬂm

~ Papier
Talle: -

Source : I Sélection automatique j

~ Orientation Marges [milimétres)

' Partrait Gauche: |25.4 Droite : |25.4
" Papsage Haut 25.4 Bas: |25.4

oK I Annuler I Imprimante. I

* The Print function alows you to export .pdf document pages. Graphics are exports in a vectorial format in
order to scale its whithout deterioration.

@B GRIF - Fault-Tree Module
() Print whole document

) Print current page

‘@ Print select :

[ = icons.bool

o [][&] FaultTree 1

¢ [H{== EventTree 1 £«———————— Partially selected page
o [] 3 graphiques
o [¥] 3 matrices

o []5d SafetyLoop 1

o [] g=4 BlocDiagram 1

o [v] B EventTree 2

Print partially selected pages
Printing properties

Print border

Print filename

Print page number

Print date

| OK | cancel | Help ‘

The print window appears and user can selected pages to print and configuration.
¢ Print whole document : Allows to print whole document.
e Print current page :Allowsto print the current page.

» Print select : Allowsto print the selected pages. The Print partially selected pagesallowsyou to print pages
marked by a blue square.

e Print border : Print aborder on each page.

« Print filename: Print the filename on the top |eft corner of each page.

* Print page number : Print the page name and number on the bottom of each page.
« Print date: Print the date on the top right corner of each page.
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» TheSavein RTF file... functioninitially gives accessto awindow called Printing properties. Then to another
caled Information. And thirdly, awindow is displayed allowing you to choose the folder in which the RTF
fileisto be saved.

Printing properties

Print border

Print filehame
Print page number
Print date

| OK I Cancel |

When you select the Savein RTF file function, thefirst box to appear is that shown above. Y ou can then select
your preference: Print border, Print filename, Print page number and/or Print date.

Information

Print current view

[ Print current page

[ Print whole document

Secondly, an I nfor mation window appears. It allowsyou to indicate whether you wish to print the current view,
print the current page or print the whole document.
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/. Computations

The following two computation engines can be used in the Fault Tree module:

* Albizig
« MOCA.

These two computation options are accessible in the Data and Computations menu on the task bar.

7.1. Albizia computations
The computations by Albizia are performed in two main steps:

 genera configuration of compuation;
* reading the results in the bank of results.

7.1.1. Configuring the computations

The computation configuration window can be accessed in two different ways: either viaData and Computations
- Computation settings menu or via Data and Computations - Launch Computation menu. The difference
between both isthat, in the second case, the configuration step isdirectly followed by the computation launch step.

The configuration window which opensis called L auching Albizia computation.

The configuration window is divided into 3 tabs (1 for each type of computation).
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7.1.1.1. Configuration of probabilities computation

Running Albizia cormputation @
(| Probabilities | Frequencies r Minimal cut sets |/ Importance factors ertions |

Target |Allthe nodes ‘V| | |

Computation times

i Automatic list of points between 0 and

) lterate  From To Step

® Listof times |3760 |

[] Display discontinuity points Times in =

[ ] Compute mean value and integral through [0, f]

[ ] Activate propagation of uncertainty

fe]

Computation types
Unavailabitity: Q(t), U(t) or PFD(t) [ ] Availability: A{t)
[] Unconditional Failure Intensity: UFI{t) or W(t)
[ ] Conditional Failure Intensity: CFl(t) or Equivalent A{t)
[] Approximate Unreliability: F(t} [] Approximate Reliability: R(t)

[] calculation of time spent in zones

| OK I Cancel Help |

e Target: specifies the target of the computations. Two choices are possible : Top for the top(s) of the tree and
Selected node for the node currently selected in the tree.

» Computation times; specifies the computation options.

Iterate From A to B step C: the computations will be performed for values of t ranging from A to B with
astep of C.

List of times: the computations will be performed for the values of t given in thislist.

Display discontinuity points: the computation enginetakesinto account the discontinuity pointsif theoption
is selected.

Timesin: The values entered are supposed to be hours. The unit can be specify among hours, days, months,
years

Compute mean value through [0, t]: the computation engine computes the mean value of each variable to
compute for each computation times.

Compute integral value through [0, t]: the computation engine computes the integral of each variable to
compute for each computation times.

» Activate propagation of uncertainty: activate the propagtion of uncertainties, and specifies parameters of
computation and wanted resullts.

Number of histories : Number of histories (Monte-Carlo simulation) that have to be made.

Confidence range at : specifies the percentage of resultats that will be included in the confidence range.
Quantiles chosen : With all results of histoires, the software do a "quantile computation”. But there are
always many ways to chose bounds of an interval containing X % of the results. Here you can chose "on
the left" (lower bound is minimum, upper bound is the quantile at X%), "onthe right" (lower bound is the
quantile at 100-X%, upper bound is the maximum) and in the middle.
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» Probabilities: specifies probabilities to compute.

» Unavailability: Q(t), U(t) or PFD(t) according to different standards and countries.

* Availability: A(t) =1 - U(t)

¢ Unconditional Failure Intensity: W(t), UFI(t) or PFH(t) according to different standards and countries. It
is the probability that the system fails between t and t+dt, assuming systeme was OK atime t=0.

Conditional Failure Intensity: CFI(t), Aeq(t) or AVesely(t) according to different standards and countries.
It is equal to W(t)/A(t) It isthe probability that the system fails between t and t+dt, assuming systeme was
OK at and at time t=0.

e Unrédliability : F(t) = 1- R(t)

* Rdiability : R(t) = R(t)=exp[-(Integra from O to t) of Aeg(u)du]. We can see here that this reliability
is based on an equivalent lambda, and not on the rea lambda. This is a good approximation that is
conservative. Anyway, you can not compute the reliability with a fault-tree. For systems made with
unrepairable components, the result is excat (because it is equal to Availability).

e Calcul de temps passé dans les zones : Pour les valeurs ci dessus, cette options permet de savoir quel
pourcentage du temps elles sont restées danstel ou tel interval. Cesintervalles sont configurables en cliquant
sur le bouton configuration. Ils sont par défaut configurés pour les calcul SIL.

™. GRIF - Fault-Tree Module
Probabilities Zone Names of zones
Probability (Q) Zone for PFD

UFI (W) Zone for PFH

CFI (Equivalent A)

OK Cancel Help
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7.1.1.2. Configuration of cut sets calculations

Running Albizia computation

|/ProbahilitiesJ'Frequencies rMinimalcutsets rlmponanceiactors |/Dptions |

X3

Target |Allthe nodes ‘v| |

Options

[ ] Number of cut sets
Humber of cut sets per order

List of cut sets

Limiting order of displayed cut sets |3| ‘v|
Compute probability of cut sets att= (3750

Computations to be done

Do a cut sets computation with failure modes.
[] Do a cut sets computation with components.

[ ] Do a cut sets computation with systems.

OK I Cancel Help

» Cible: permet de définir lacibledes calculs. Deux choix sont possibles: Sommet pour le(s) sommet(s) del'arbre
et Noeud sélectionné pour le noeud actuellement sélectionné dans I'arbre.

e Number of cuts: number of minimal cuts of the system (no maximum order limitation).

e Number of cutsper order: summary of the number of cuts for each order (no maximum order limitation).

e List of cuts: list of minimal cuts of the system. The maximum order can be set thanks to the Limit order of
displayed cuts option.

e Limit order of displayed cuts: specifies the maximum order of the displayed cuts. Cutswith order greater than
the maximum order are not displayed.

« Compute probability of productsat t=: specifieswhich time will be used to compute probabilities of cut sets.
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7.1.1.3. Configuration of importance factor calculations

Running Albizia computation

|/ProbahilitiesJ'Frequencies rMinimalcutsets rlmponanceiactors |/Dptions |

X3

Target |Allthe nodes ‘v| |

Computation times

) Automatic list of points between 0 and

) lterate  From To Step

® Listoftimes |3760

[ ] Activate propagation of uncertainty

Number of histories

Quantiles chosen

Computation types
Birnbaum (MIF} Risk Achievement Worth (RAW)
[v] Critical (CIF) [_] Risk Reduction Worth (RRVV)

Fussel Vesely (DIF)

[ | Display discontinuity points Times in =

[ ] Manual selection of MIF algorithm

OK I Cancel

e Target, times, uncertinties: cf. probabilities calculation
« Computation type: specifies the importance factors to compute.

e Birnbaum (MIF)

Critical (CIF)

* Fussal-Vesely (DIF)

Risk Achievement Worth (RAW)
* Risk Reduction Worth (RRW)

The manual configuration of MIF computation allows you to chose MIF algorithm.

» Partial derivative: Uses quick algorithm based on partial derivative. To be used with coherent fault trees only)
» Exclusive Cofactor: Uses (less quick) algorithm using Exclusive cofactor S#. It stays valid with non-coherent

fault trees.
» BDD: Usesagorithm using BDD (only for coherent fault trees)

With automatic mode, the Partial derivative algorithm is used, execpt for non-coherent fault tree (Negation,

XOR, IfThenElse ...) where St is used.
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7.1.1.4. UFl computation configuration

GRIF (with Albizia engine) enables to compute UFI on non-coherent fault tree. The automatic mode takes into
account almost cases, but user can select which algorithm to use. There istwo way for UFI computation:

* UFI computation with MIF: It is"usua" method. Let be a System S made of many components c, the UFI

(also called w) of Sisequal to UFls = ws2 MIF(S,c)*w.. This algotithme is|ess performant than the one based
on BDD, but it works for non-coherent fault tree (if the MIF iswell computed).

* UFI computation with BDD: It isthe "fastest” methode which is base on BDD. This method doesn't work for
non-coherent fault trees, except in the particular case of initiator events (cf option below).

In order to exmplain the Take failure order into account " not-initiator” then "initiator" option, lets take a
simple example : un system made of one safety barrier which set the systeme in a safety state if an initator event
is detected. The top event isan initator event which is not detected by the barrier. The frequency of thistop event
istheresult of two cases:

» Thebarrier isalready out of order (with some probability) and theinitiator event happens (with somefrequency)
« theinitiator event is already here (with some probability) and the barriersfails (with some frequency)

The second case doesn't matter because the system is set in a safe mode. That why this case can be removed
from UFI computation. It is what is done if user check Take failure order into account " not-initiator" then
"initiator" option. This options works the both agorithms. Moreover, this options allows you to use UFI
computation with BDD if initiato part is coherent.

7.1.1.5. Configuration of Lambda computation method for CCF

When using common cause failure, the software must compute alambdaCCF that will be used for CCF. It isthe
one that will be multiplied by Beta. Assuming each component impacted bay a CCF has a different lambda, there
are many methods to compute the lambdaCCF from the list of lambdas. Five methods are available :

* Minimum: This method uses the minimum value of lambdas. Not recommanded.

* Maximum: Uses the maximum value of lambdas to be concervativ. This method was used in GRIF 2013 and
previous version. It can be penalizing when lambda of components are very different.

» Average: This method uses the artimetic mean of lambdas.

» Geometric mean (PDS Method): This method uses the geometric mean of lambdas. It is PDS Method
recommanded by SINTEF. It works fine with very different lambdas.

* Quadratic mean: This method uses the quadratic mean of lambdas.

Computation of A for CCR: @

The lambda of a CCF is computed from lambdas of impacted components.
Please select a computation method:

) Minimum

® Maximum

) Average maX Ai
) Geometric mean l

) Quadratic mean

OK I Cancel | Help

Les résultats sont présenté sous la forme d'une fenétre composée de 4 onglets.

 Probabilité
» Facteursd'importance
» Coupes
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« XML

The Probabily tab gathers all probability computations. The top part displays the percentage of time spent in
each zone (if needed). Then a synthesis tablea diplays minimum, maximum, mean/average and sum. If it is a
computaion with propagation of uncertainties, a column diplays the confidence range of the average.

™ GRIF - Fault-Tree Module E3
| Probability | Importance Factors | Products | XML | Standard output |
Time spent in zones {Percentage)
PR | UFI
System SIL4 [0,1E-4] SIL3[1E-4,1E-3[ SIL2 [1E-3,1E-2] SIL1[1E-2,1E-1] SILO[1E-1,1]
Sensor: 1 0.0004% 0.0034% 0.0346% 0.386% 99 5755% -
RevealedSafeFailure_... [0.0011% 0.0103% 0.1095% 99 8791% 0% =
RevealedDangerousF... [0.0011% 0.0103% 0.1033% 1.088% 98.7973% f
Synthesis
(‘PR | UR | LBDEQ |
System Min Max Mean Sum Mean
Sensor: 0 1 0.9473 3.2083E3 [0.9473,0.847 3] -
RevealedSafeFailure_... [0 9.0909E-2 8.9961E-2 7.5806E2 [8.9961E-28.9961E-2] |—
RevealedDangerousF... 0 0.9995 0.8859 7.7601E3 [0.8859,0.8859] —
HidenFailure - 1 0 01 9948 01 3879 T TA01F3 [0 8550 0 83A/49] -
Hame |V‘ |Type ‘V|
PR | "un | LBDEQ |
Mame
HidenFailure : 1 ;| Type = PR, Name = Sensor: 1 Q
RevealedDangerousFailure : 2 :
RevealedSafeFailure_2: 3 : Time Value Mean Sum Standard De...|bound quanti..|bound quanti..
Sensor : 1 g L1 0 0 0 g g 0 -~
§§ 2.4E1 6.6971E-2 3.3485E-2 0.8037 0 6.6971E-2 6.6971E-2 =
§§ 4 8E1 0.1254 6.4839E-2 3.1123 0 0.1254 0.1254
§§ 7.2E1 01772 9.3658E-2 6.7434 0 01772 0.1772
§§ 9.6E1 0.2236 0.1203 1.1563E1 0 0.2236 0.2236
§§ 1.2E2 0.2658 0.1452 1.7426E1 0 0.2658 0.2658
§§ 1.44E2 0.3044 0.1685 2.4268E1 0 0.3044 0.3044
§§ 1.68E2 0.3401 0.1905 3.2002E1 0 0.3401 0.3401
§§ 1.92E2 0.3733 0.2113 4.0563E1 0 0.3733 0.3733
§§ 2.16E2 0.4043 0.231 4.9895E1 0 0.4043 0.4043
H2.4E2 0.4335 0.2498 5.9948E1 0 0.4335 0.4335 —
ff 2 RAED N ARMG N I357TT T NROE4 [l N AROG N AENGC -
mercredi, 26 janvier 2011 16:31:35 CET %
Save and exit I Exit without saving ‘

Importance factor s tab displays importance factors for each events and for each system.

Products shows results of cuts/products computations. In synthesis, a cut with a 0" order, means that the top
event isawaystrue. It may happen if some parts are "forced to 1".

XML tab contains Albizia output.

7.2. MOCA computations

The computations using MOCA-RP V12 are performed in three main steps:

» genera configuration of parameters;
 thelaunch itsdf;
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* reading the resultsfile.

7.2.1. Configuring the computations

The computation configuration window can be accessed in two different ways: either via menu Data and
Computations - Moca Data or via Data and Computations - Launch Moca 12 .... The difference between the
two isthat, in the second case, the configuration step is directly followed by the computation launch step.

The configuration window which opensis called General I nformation:

Start Moca computation

Title |Dem0.jog

Default compute times

) Times or list of times (separator=",")

i@ lterate From |1 | To [15

| step |1 |

Computation made at:‘t (after triggering transition) ‘ - |

fGeneraI r‘u’ariahles |/ Qutput options |/ Advanced options |

riesin et |

Number of histories (100
1st random Humber |[1.2345681E7
Maximum calculation time (sec.) |1000000.0

Automatic history duration

Multi-processors computing

[] Activate uncertainty propagation

Performance: 94 historiesiminute/CPU
Approximative computation duration: 8 Second{s)

OK I Cancel

Help

This configuration window is divided into five parts:
1. Title: allowsyou to give atitle to the resultsfile.

2. Default computation timesfor statistic states:

 lterate From A to B step C: the computations will be performed for values of t ranging from A to B with

astep of C.

 List of times: the computations will be performed for the values of t given in thislist.
« Computation made at: by default, computations are made immediatly after trantion triggering, but you can

do computation at t-Epsilon (just before triggering), or at both.

 Unit: default times unit is"hour". Y ou can choose a unit that will be used for computation times. N.b. results

are alwaysin hours.

3. General:

* Number of histories: Number of histories (NH) to be simulated (each history hasatimet indicated below).

» First random number: It is the seed of random number generator.

* Maximum computation time (MT): The computations are stopped and the results are printed even if the

reguested number of histories has not been reached.
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Note: the unit of time (MT) is the second.

» Automatic history duration: If thisbox is checked, GRIF will compute history duration using computation
time of variables and statistical states. If not, user can choose a specific History duration

* Multi-processor s computing Enables (or not) the multi-processor computing (when available).

» Activate uncertainty propagation Enables (or not) the uncertainty propagation computations (two-stage
simulation): in this case we must specify the number of sets of parameters "played" (the real number of
histories thus simulated will be the "number of sets of parameters x number of historiesto be simulated” and
will be displayed in the "Total number of histories' field).

4. Variables: Thistabs reminds comuting configuration of variables. If document contains some statistical states,
another tab isavailable.

5. Output: used to configure the output.

* Printsthe description of the Petri Net in the results file (or not)

» Printstheresultsfile allowing it to be loaded using a spreadsheet application (such as EXCEL)
* Printsthe censored delays (or not)

» Number of outputs during simulation. If 2 outputs, there will be an output at NH/2 and at NH.

6. Advanced options: used to configure the advanced options.

* You can choose the limit of transitions fired at the same time before loop detection.

Since GRIF 2010, results are displayed in a windows with many tabs and tables.

7.2.2.1. Moca Results

Moca results atre displayed in a window containing 6 main tabs : variables, places, transitions, XML, stantard
output, info.

7.2.2.1.1. Tab of Variables
The Variablestab contains every information computed for each variable (or statistical state).

» Value: Contains every vaue of avariable for every type of statistic.

» History (at the end of histories) : contains historical values for each computed statitic.

» Fixed size Histogram : Contains histograms computed by Moca (cf chapter about histograms)

» Equiprobable classes Histogram : Contains histograms computed by Moca (cf chapter about histograms)
» User defined Histogram : Contains histograms computed by Moca (cf chapter about histograms)

» Timeline: Contains atimeline for each variable. Times are automatically computed by Moca.

7.2.2.1.2. Tab of Places

It contains sojourn duration and mean mark for each place of Petri Net.

7.2.2.1.3. Tab of Transitions

It contains firing frequencies for each transition, and firing history for each history.

7.2.2.1.4. Other tabs

Other tabs display "raw" results. XML tab contains XML output of Moca, it is the file used to retrieve data. This
file can be used for further post-threatments.

Standard output display the standard output of Moca (available only afer computing).

Info tab contains usefull information about computation (simulation time, number of histories that have been
done...)
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7.3. Tables and Panels to display results

7.3.1. Result-tables

Result-tables are made of data and a top part to set table up.

Type = TS3, Name = failures | [ |ld
Time Walue Z190% Standard Dewi...| Cllower baund | Clupper haund

0 1] 0 1] 0 0 -
BYEO0(-£) 0.861 3.4305E-2 049345 0.8267 0.8953

8760 0861 3.4305E-2 0493455 0.8267 0.8953

17520 (-] 17215 4 7AB4E-2 1.2876 167349 1.76591

17520 17215 4 7AB4E-2 1.2876 167349 1.76491

2E280(-£) 2 A685 574931E-2 147497 25106 26264

2R280 2 AE85 574931E-2 147497 25106 26264 3
35040 (-2 34345 f.815E-2 1.8584 3.3674 3.5036

34040 34345 f.815E-2 1.8584 3.3674 3.5036

43800 {-£) 4.3 7.7184E-2 21048 42328 43872

43800 4.3 7.7184E-2 21048 42328 43872

52560 {-£) A17T 5.484E-2 23135 50922 52618 —
52560 A17T 5.484E-2 23135 50922 52618

B1320 (-] 6018 §.1258E-2 24885 59267 £.1093

£1320 6018 §.1258E-2 24885 59267 51093

TO080 (-2 BH245 9.8163E-2 2 GH7EB 58263 70227 =

inininln} E 074 s 004230 7 D ETED | i e ]

Columns can be sort by clicking on their header. The v filter icon activates a filter set-up with the following
window:

Associate tests with: @ AND () OR Add a criteria:

‘Name |V‘ |cuntains |" |Test | | i} ‘
“u‘alue |V‘ |greaterthan |" |1| | | i ‘
| 0K I Cancel |

When filter is activated, asmall (+) is diplayed near column title. Filter can be remove with ¥ button.

7.3.2. Export data
Vauesthat are visible in this table can be exported in CSV file format with [x] button.

Results can also be displayed with a Curve by clicking on 2. Data used for x-axe and y-axe must be specified
in the following window:

Set curve up
" —
X-Axe ‘Time | h ‘
Y-Axe value |~
[ Confidence range | -]

| OK | Cancel |
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Then, chart is displayed in awindow :

Yalue

1E2
SE1
2E1
TE1
GE1
SE1
4E1
3E1
2E1
1E1

1E4 2E4 3E4 4E4 5E4 GE4 7E4 2E4 QE4
Time

|— Type=T53, Name = prod |

‘ Save curve into document ‘

1ES

OK

Chart can be saved in the current document with the button at the bottom.

Nb : when chart isin document, points are no more modifiable.

7.3.3. Result-Panels

Result-panels have been created to facilitate data access in tables with many columns. The aim isto make a prior

filter to keep wanted data.

] e [
{["PR [ vm | LBDEQ |
Name |
PT indiv ‘| Type = PR, Name = PT indiv 7| 13 |4
LS 5
PSD KO : Time Yalue Average Integral
PTs Ko H L0 0 0 0 e
PT1 i|1E-9 0 0 0
P12 ill4.38E2 1591E-8 7.9552E-9 3.4844E-6 =
PT CCF ill8.76E2 6.3633E-8 2.3863E-8 2 D904E-5
PV il1.314E3 1.4316E-7 5.0374E-8 B.6191E-5 |
W 1.752E3 2 5447E-T 8.7484E-8 1.5327E-4
2.19E3 3.9756E-7 1.3519E-7 2 9606E-4
2.628E3 5 7241E-7 1.9349E-7 5.0849E-4
3.066E3 7 7901E-7 2 6238E-7 8.0445E-4
3.504E3 1.0174E-6 3 4185E-7 1.1979E-3
3.942E3 1.2874E-6 4 31ME-7 1.7026E-3
4.38E3 1.5892E-6 5.3256E-7 2.3326E-3
4.818E3 1.9227E-6 6.4378E-7 31017E-3
5.256E3 2 2879E-B 7 B5TE-7 4 0238E-3
5.694E3 2 6B4BE-6 8.9794E-7 51129E-3
6.132E3 31133E-6 1.0409E-6 6.3826E-3
6.57E3 35735E-6 1.1944E-§ 7. B4TE-3
7.008E3 4 0653E-6 1.3584E-6 9.52E-3
7 A46E3 4 5388E-6 1.5331E-6 1.1415E-2 <
QOACD EAA2OC F 4 A09C B 4 JEATC T

This panel is made of a combo-box in the upper-left corner which enables to remove the column from the table
and creates alist on the left which contains every values in the removed column. When you select avaluein the
left list, it modifies the table in order to show lines whose removed column contains the selected value.
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The combo-box in the upper-right corner enables to choose which column C will be used to cut table. The table
will be cut in many tables, each onein atab whose titleis equal to the value used to filter the C column. Then C
column is removed since it contains only the one value in a given tab.

7.4. Batch computation

In order to do fast sensibility analysis or to compare someresultswith different parameters, it can be very usefull to
do calculation one after another automatically. To do this, usethe Data and Computation / Batch computation ...

menu.

Name of batch: |First Sensitivity Analysis

Numberofcomputations:zjj

e

Name of computation: |Computati0n‘l

Computation Options:  Modify...

Modifications on the model

Add modifications j J Remove modifications

‘Parameters ‘VHIambda

|VHValue |V‘ 1.0E-5

‘Parameters ‘vHMu

| v value |¥| 0.4

| Launch I

Cancel | Help

The batch launching window is made of two part, the first is for the name of the batch and the number of
computations in the batch. Then each computation can be set up :

* Name of computation: for identification in results
» Computation options. contains every options related to this computation (times, types ...)

* Moadifications on the model: specifies modifications that will be made on the model before computation
launching. You can add as many modification as you want with the + button. Each modification is made of

4 parts:
1. 1 drop-down menu for object type

2. 1 drop-down menu for the object that will be modified
3. 1 drop-down menu to spécify what will be modified on this object (value for a parameter, law for other

object ...)
4. Then you must enter the new value in the cell

The above exemple shows a batch with 2 computations, the first is made with a lambda parameter with 1.0E-5

value and a mu parameter with 0.1 value.

After acomputation, the model is always reset up to an initial state without modification.
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7.5. Result Bank

Every GRIF computation is stored in result bank which is avalable on the right of the module.

( Parameters |/ Events r Gates r Result Bank |_

(2 b X

Ij Computations

A [ default-Albizia

i D default-Moca

|l ¢ & Bateh for Sensitivity analysis|

: D Computation with lambda = 1E-5
D Computation2 with lambda = 5E-G
; D Computation3 with lambda = 1E-G
¢ &t Frozen computation for curves

: [y Frozen: Test1: 1

Tl

You can display aresult with a double-click on it. There is a default result for each computation engine, it isthe
placewhere"standard" complutation are stored. Then, each ' isabatch computation directory, it contains as many
results as computations aked for the batch. Finally, the #:directory containsresultsfor curvesthat have been frozen.
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8. Curves

The curves can be drawn to study the model and the results better. To do this, click left on the corresponding icon
on the vertical task bar then draw a box. This box will be the space assigned to displaying the curve(s). Initialy
it isonly awhite box with two axes without graduation.

Chartsicon:

L

We must now define the curvesto be drawn. To do this, click right on the box to display the Charts Edit window.

8.1. Edit curves window

The edit curves window is the same for all the GRIF modules.

™ charts Edit

Charts title: [Evis] |

Data List
I | i
Legend Information Show| Color Style ﬁ i“f‘;
Curve JPR/Ewt1 V] Mo point 1| O
Curve? JPR/EW2 V] Mo point 1( O
Style
Type: |Linestyle |V‘

Intervals : |Automaticwithout peak | v‘ Display peaks values at :
X axis unit: = | [ |Log
Y axis unit: I:l:l = | [ |Log

Areas: =

Display options
Display title:

Display generic values:

0K I Cancel Help

The window is divided into several sections:

1. Chartstitle: entersatitle for the graph.
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2. Data list: this part includes a table with several columns in which the different curves on the graph are listed
(name, description, display, curve colour, curve style, curve thickness, display average). A number of different
buttons are available above thistable.

L : Selects aresult of computationsto display. It sends the user back to the Select results window to add a
curve plot to the graph (see. Section 8.2.1, “ Curves from data in result-bank™).

4 : Compares several resultsfrom different calculationsfor the same data. It sends the user to the Compare
results window to add a curve plot to the graph (see Section 8.2.2, “Comparative curves from datain results
bank ).

« Edit: editsthe plot of the selected curve.

Delete bal : deletes the plot of the curve selected on the graph.
Up 1 : moves up the plot of the curve selected in thelist.

Down + : moves down the plot of the curve selected in thelist.

» Save: savesthelist of pointscal culated to plot the selected curvesin .csv format. Thisexport does not contain
the generic values. To obtain an export with the generic values, right click on the curve and select I ndividual
export.

» Duplicate: creates a new curveidentical to the curve selected.

Freeze ™ : freezes the display of the curve, which will no longer be updated automatically according
computation results.

For each curve, the user can specify the colour, point style, line thickness and display.

3. Computation options. enables the user to enter settings for the computation (optional depending on the
module).

4. Style: this section concerns the curve display.

» Type of style: specifies the type of al the curves on the graph (line, histogram, etc.). N.B. In the case of a
histogram, the bars that exceed the display areawill be displayed in shading to show the user that ghe must
change the display intervals so that the entire bar can be displayed.

* Intervals defines the display limits for the curve. Automatic without peak: the graph will not display the
"pesks' of specific cases of exceptional values which would make the graph illegible. Even if the peaks
are not displayed on the graph, the user can display their values using the choices proposed in the option
Display peak values.

» Xand intervals: specification of the display interval on the X and Y axes (default intervals or intervals
defined by the user). The last function enables usersto "zoom in" on the most interesting parts of the graph.

» Theaxisunit can be selected according to the type of computation result. For example for units of time, the
user can enter hours, days, months or years.

The “® button determines whether or not the unit is displayed on the graph.

» Thelog boxesare used to activate the logarithmic scale on the axisin question. N.B. 0 cannot be represented
on alog scale, remember to enter a start value that is strictly positive (e.g. E-10). If O is entered, the log
scale will begin at an arbitrary value E-15. Where the computation engine allows, the trust interval can be
displayed by ticking the corresponding box.

» Areas: distinguishes arange of values on a coloured background.

* Inthe histogram style, abox can be ticked to create a cumulative histogram.

5. Display options: activates the Display title function (display graph title) and the Display generic values
function (display min, max and average for each curve).

When a curve is edited, the edit curve window often includes 3 parts: the times at which the computations are
performed, what has been calculated and the extra information (generic values) that should or should not be
displayed below the curve.

Comment: it is sometimes necessary to refresh al the graphs in a document. This can be done using the Tools/

Refresh command, or the keyboard shortcut F5 or the % icon.
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8.2. Selection of results window

8.2.1. Curves from data in result-bank

When you click the Add button in the Data list part you reach a window for curves setup. Each curve displays
data stored in the result-bank. The following window helps users to specify how to retrieve data.

EGRIF - Fault-Tree Module

Legend: |Cuwetl

Computation selection

] Computations
[y default-Albizia
D default-Moca

o B lambda

4

<]

Result to be displayed

=/
¢ [C] Gates and Events
9 3 Probability (Q)
[y And1

[y Bvt1
=

[»

[4]

4] i

|Dis|jaythei5tofp(int5

|v‘

X-Axis ﬂ

Value to be displayed

Minimum Maximum

Average

| OK | cancel

Help

» Legend: legend of the curve.

« Computation selection: select the computation in the result-bank.

» Result to be displayed: each computation contains many results. Select the one you want to be drawn.

» Vousavez lapossibilité d'afficher laliste des points en spécifiant |es données voulues sur chacun des axes ; ou
vous avez la possibilité d'afficher les temps passés dans les zones.

» Axes: When aresult is selected, select what must be in X-Axe and what must bein Y -Axe.

» Valueto bedisplayed: Then you can display addition informations about the result (min, max, moyenne ....)
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8.2.2. Comparative curves from data in results bank

When the user clicks on Compar ein the Data list section, awindow opens enabling the user to specify the curve
to be plotted. S/he can then choose whether or not to display a result from severa different computations. The
following window is used to indicate the way in which the information is to be recovered.

T GRIF - Fault-Tree Module E

Legend: |CuweD |

Computation selection
[ lambda=2.0E-4
[} lambda=3.0E-4
[} lambda=4.0E-4
[} lambda=5.0E-4 -
[} lambda=6.0E-4
[ fambda=.06-4]
[} lambda=5.0E-4
[} lambda=9.0E-4

o= #% Frozen computation for curves -

| »

Result to be displayed
=/ il
¢ [C] Gates and Events

¢ [ Probability (Q)
[} And1

[ Ewtd
[ Evt2

Information to show =

For which point 7

4]

) When the is equal to

i

& The Dernier point =

Display X-Axis values according to =

Value to be displayed

Minimum Maximum Average

| OK | cancel Help

» Legend: curvelegend.

» Computation selection: the user can select the different computations to be used from the results bank. Hold
down the Ctrl button to select several different computations.

» Result to bedisplayed: acomputation often contains several results and thisfiletree structureis used to specify
the result that the user wants to display.

» Information to show: indicates which data are to be displayed on the y-axis.
» For which point?: indicates which point of the computation isto be compared to the others.
» Display x-axis values accor ding to: indicates which data must be displayed on the x-axis.

» Valueto bedisplayed: finaly, certain extra data can be displayed (min, max, average, etc.)
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9. Databases

In each GRIF module a connection can be established to a database. It is possible to have two different types of
connections:

» connectionto aCSV file;
» connection viaa JDBC link.

9.1. Connection to a CSV file

9.1.1. Form of the database

This type of connection isthe simplest to make. A CSV file has the extension ".csv". It isasimple text file where
the different fields are separated by commas, tabs or semi-colons. It is the simplest form of database.

[[D,NOM, VALEUR , DESCRIPTION, DIMENSION
000001,Lambda,0.001,Exemple de Lamda,RATE

000002 ,Mu,0.01,Exemple de Mu,RATE

000003 ,Gamma,0.5,Exemple de Gamma,PROBABILITY

000004 ,ProdMax,1000.0,Exemple de Production maximum,0THER

9.1.2. Connection

To connect GRIF to this database, go into menu Tools - Connection to a CSV file. A dialogue box is then
displayed:

™ patabase
CSV file to be used as database
‘C:1.Users\bdecournuaud‘.workspaceUaGrifeurumTH | Test |
Name of "ID" field: 1D
Name of "name" field: MNOM
Name of "value" field: VALEUR
Name of "description” field: DESCRIPTION
Name of "dimension” field: DIMEMNSION

Separator: ® ' (% O 'tab’

OK I Cancel Help

Thiswindow is divided into three parts:

* You must initially enter the path leading to the CSV file. To do this, there is an explorer available (... button).
A Test function is used to check the connection.

* You must then enter the names of the four fields of the CSV file.
» Finally, specify the types of separators used in the CSV file.
Note: A CV S connection must be made with aCV S File (which means generated from only one sheet of aEXCEL

File).
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9.2. Connection via a JDBC link (example with ODBC connector)

9.2.1. Form of the database

The database can initialy be in the form of an EXCEL or ACCESS file. Then, using the operating system, an
ODBC system data source must be created. In the case of WINDOWS, for example, this operation is performedin
menu "Control Panel - Administration tools - data source (ODBC)". Here is an example of an EXCEL database:

4 ProdMax 1000.0

S I = L I SR S

9.2.2. Connection

al B | ¢ ] D | E | F
D NOM VALEUR DESCRIPTION DIMENSION

1Lambda 0.001 Exemple de Lamda RATE

2 NMu 0.01 Exemple de Mu RATE

3Gamma 0.5 Exemple de Gamma PROBABILITY

Exemple de Production maximum OTHER

To connect GRIF to this ODBC database, go into menu Tools - Application options - Database. A window is

then displayed which must befilled in as follows:

Options rGraphics rDigitaIiormat |/Events rGatesfShortcuts |/Cunres |

Executables

Use DataBase connection for parameters:

Name:

GRIF - Fault-Tree Module E3
Database Language |
MDD _09

JDBC Driver:
Connection to database:

Connection options:

‘0rg.requue.jdbc.csv.CsvDriver

‘jdbc:requue:csv:..s’TooIstatabasea’

|

|

|

|

Login: ‘Login |
Password: ‘F'ass |
SQAL Request: ‘ 1D,NOMVALEUR, DESCRIPTION DIMENSION FROM REK|
Hame of "ID" field: ‘ID |
Type of ID: ‘VARCHAR[BE} |
Hame of "name" field: ‘NOM |
Name of "value" field: ‘VALEUR |
Name of "description” field: ‘DESCRIF’TION |
Name of "dimension™ field: ‘DIMENSION |
‘ Test Connection |

OK Cancel Help ‘

Notes:

1. sun.jdbc.odbc.JdbcOdbcDriver isthe driver name

2. jdbc:odbc:REX specifies that "REX" is the name of the ODBC link
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3. Thefields Connection options, L ogin and Password are unnecessary here.

4. SELECT ID,NOM ,VALEUR,DESCRIPTION FROM [Feuil1$] iscalled thequery where Feuil 1 isthename
of the EXCEL sheet containing the data.

9.3. Operation

The aim isnow to link some of the model's parameters to the database. To do this, start by displaying the column
Linked toin the parameters table (click right on the top of the columns).

Select columns that have to be displayed and their order
[w|Name
[w]Value
v|Linked to 4
[w]Last database

| oK |  cances Help

Then double click in the Linked to column to display the database items. When one of these items has been

selected, click OK to validate the connection. The parameter then takes the value of the item to which it is now
connected.

10 Mame in datab., MNew value Description Dimension
1 Lambda 0.0010 Exemple de L... |Rate
2 Mu 0.01 Exemple de Mu |[Rate
3 Gamma 05 Exemple de G...|Probability
4 ProdiMax 1000.0 Exemple de P... |Other
Remove link to database
0K I Cancel Help

Note: The button called Removelink to database at the bottom of the table breaksthe link between the parameter
and the database item.
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If some of the database values to which GRIF is linked are modified, the parameters connected to this database
can be updated. To do this, select Data and computations - Update from database... and display the Database
window.

‘ Select all | ‘ Update selection ‘
3
MName Value Linkedto (+) |Nameindata.| MNewvalue |
Lambda 0.0010 Lambda (id=1) |Lambda 0.0010 T
Mu 0.01 Mu (id=2) Mu 0.01
Gamma 05 Gamma (id=3) |[Gamma 0.5 —
ProdMax 1000.0 ProdMax (id=4) |ProdMax 1000.0
q] I D] |
| 0K I Cancel Help |

The parameters whose values are not up to date are automatically detected and indicated in bold. One or more
of these parameters can then be selected for updating using the Update selection button. Two other buttons are
availableto simplify the selection process: Unselect all (deselectsall thetable's parameters) and Select all (selects
all the table's parameters).

Remark: you can also directly copy parameter from database using menu Data and Computation/Database/Copy
parameters from database. A window is displayed, you can select parameters you want to copy into document.
Parameter will be automatically linked to the right paremeter in database.

ID |Mame in databa...| Mew value Description Dimension
1 Lambda 0.0010 Exemple de Lamda Rate
2 Mu 0.01 Exemple de Mu Rate
3 Gamma 0.5 Exemple de Gamma Probability
4 ProdMax 1000.0 Exemple de Production max...|Other
oK | Cancel Help
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10. Save

Hereisasummary of all the data which can be saved from a same model.

10.1. Model

It is obviously possible to save and reload the models which are made. To do this go into menu File - Save or
into File - Save as....

Flel Edit Tools Document Fault-Tree Dataand Compuil

% New Ctrl-N
II'_'?@De New (from template) ... I
& Open ... Cirl-O
Save Cirl-5
Save as ...

Save as template document
Anonymize

4 send by e-mail ...
Export »
Close Cirl-F4

&, Page layout ...
& Print... T
Save in RTF file ...

Statistics of document
Document properties

CiUsers\bdecournuaud\GRIF201 3\ Tree Tree.jtr

Quit Ctrl-Q

The Save astemplate document menu enables the user to save the document as atemplate in the Modul e template
folder. New files can then be created using this model and the action New (from template)...
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10.2. RTF File

A model can also be saved in RTF format. This alows the saved model to be reloaded in WORD to insert the
graphical part of the model in any document. To do this, go into menu File - Savein RTF file....

Fiel Edit Tools Document Fault-Tree Dataand Compuil

% New Cirl-N

% New (from template) ...

& Open ..

Save
Save as ...

Save as template document
Anonymize

(4 send by e-mail ...
Export »
Close Ctrl-F4

0 0

&, Page layout ...
& Print ... T
| savein RTE file ... |

Statistics of document
Document properties

CiUsers\bdecournuaud\GRIF201 3\ Tree Tree.jtr

Quit Ctrl-Q

Note: Thereisanother way toinsert model inareport. Select the part of the model, copy it, and pasteit in Microsoft
WORD or other software.

10.3. Input data

When the input data for the computation engine is generated, it can be saved. This type of file has the ".don"
extension. These files can therefore be modified using atext editor then reloaded to launch computations on them
(for example). This action should be made only by advanced user.

10.4. Results

Computation results can be saved in different formats :
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1. Export of atablein particular in .csv format:

HGRIF - Fault-Tree Module [x]
Probability r Importance Factors r Products with components r Results Info
Synthesis PR
System Min Max Average Integral
And1 0 0.9995 0.7908 6.9271E3
Evi1 0 0.9998 (0.8858 7.7593E3
Evt2 0 0.9998 (0.8858 7.7593E3
Evi3 0 0.9998 (0.8858 7.7593E3
e |+
PR
Mame
And1 Type = PR, Name = And1 .
Evt1
Evt2 Time WValue
Evt3 0 0 o
1E2 8.6178E4 |=|
2E2 5.9562E-3
3E2 1.7411E-2
4E2 3.5833E-2
5E2 6.0916E-2
GE2 9.1849E-2
7E2 01276 |
jeudi, 20 septembre 2012 13:34:45 CEST =
| oK |
2. Export entire set of results:
™ GRIF - Fault-Tree Module [x]
Probability r Importance Factors r Products with components r Results Info
Synthesis PR
System Min Max Average Integral
And1 0 0.9995 0.7908 6.9271E3
Evi1 0 0.9998 (0.8858 7.7593E3
Evi2 0 0.9998 (0.8858 7.7593E3
Evi3 0 0.9998 (0.8858 7.7593E3
e [~
PR
Mame
FZE
Evt1
Evt2 Time Value
Evt3 0 0 a
1E2 8.6178E-4 =]
2E2 5.9562E-3
3E2 1.7411E-2
4E2 3.5833E-2
5E2 6.0916E-2
GE2 9.1849E-2
7E2 0.12 save result-file rl
Advanced report ... [
jeudi, 20 septembre 2012 13:34:45 CEST Save standard output ...
Save engine data file ...
OK Save as XML Spreadsheet 2003 (XMLSS) |

» Saveresult file: savesthe contents of the Results tab (.xml format).

» Advanced report : generates reports using style sheets.

» Savestandard output : saves the contents of the Info tab (.txt format).
» Saveenginedatafile: savesthe datafile sent to the computation engine (.txt format).

» Saveas XML spreadsheet 2003 (XMLSS) : savesal theresultstablesin an XML format compatible with
Microsoft(r) Excel 2003 and later versions.
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10.5. Curves

For each curve drawn, the points which have been computed in CSV format can be saved. Thislist of points can
then be used to draw new curves or to perform further computations.

' Charts Edit [x]

Charts title: [Evts |

Data List
1 E @ ®
Legend Information Sho Color Style E Av..|
Curve1 IPRIAND1 v] Mo point 1|
Curve2 IPRIEVE2 v] Mo point 11
Curve3 IPRIEVH v] Mo point 11
Style
Type: |Lmestyle |V|

intervals : [Automatic without peak | v | Display peaks values at
Interval on X, from: to: = = []Log
Interval on Y, from; to: |:|:| = | [ |Log
Areas

Display options
Display title:
Display generic values:

0K | Cancel Help
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Tools- Application Options menu opens awindow containing the following tabs:

Executables tab enables to specify path to external executables :

» Editor path : Specifiestext editor path.

» Mail client : Enable you to set the mail client to use

» Automatically open PDF files: Specifiesif PDF reports must be opened with generation.

» Style-sheet from XML to DocBook. : Style-sheet allowing converting from XML report to docbook file.
» Style-sheet from XML toHTML. : Style-sheet allowing converting from XML report to HTML file.

» Style-sheet from DocBook to PDF. : Style-sheet allowing converting from docbook file to PDF file.

* Moca-RPC path : Specifies Moca version 12 path.

» Javaw path : Path of javaw.exe executable.

Database tab enables to configure database connection :

» Use DataBase connection for parameters: Select if database must be use.

» Name : Database name will be put into parameter during its update. It enables to know from which database
parameter has been lastly updated.

- JDBC Driver : Enter name of JBC driver to be used(sun.jdbc.odbc.JdbcOdbcDriver,
oraclejdbc.driver.OracleDriver, ...).

» Connection to database : Database Url.

» Connection options: Connection properties.

» Login : Login to be used to connect to database.

» Password : Password to be used to connect to database.

* SQL Request : Request that have to be executed to retrieve data from database.

* Nameof "ID" field : Name of field containing data ID.

* Typeof ID: Typeof ID field INTEGER, FLOAT, VARCHAR(32), ...)

* Nameof "name" field : Name of field containing data name.

* Nameof "value" field : Name of field containing data value.

* Nameof "description” field : Name of field containing data description.

* Nameof "dimension" field : Name of field containing data dimension.

» Test Connection : Name of field containing data description.

Language tab enables to choice language :

» Language : Language changes are taken into account when option windows is closed.Available language are
French and English.

Options tab enables to tune application behavior :

» Save the options of the current document as default options in the application : Save options of current
doc as application default options.

» Theapplication manages the default options of the documents. Apply the default optionsto the current
document : Apply -Application options- to current document.

» Delay of automatic document saving (in minutes) : Delay of automatic document saving (in minutes). A null
value disables automatic saving.
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Number of undo : Specifies number of possible undo/redo.

Number of recent files: Specifies number of filesin recent fileslist.

Window display : Enables separate tables (external) or linked tables (internal).

Columnsto beresized in tables : Enables to specify the columns on which space will be taken for resizing.
Manage new namesto avoid name conflict : Tries to avoid name conflict, creating new objects whose name
isunik (when pasting for example).

Add " Copy" suffix for copy-paste: If Enabled, a"copy" suffix will be added to the name of pasted objects.
Synchronize view with tables : Select objects in tables (on the right) when they are selected in view.
Synchronize view with explorer : Select objectsin explorer (on the left) when they are selected in view.

In resultswindow, display description instead of default name : Enable displaying of Comment/Description
of objectsin results window. | can be better than a default name may be without meaning.

Automatic cutting of imported files : Automatically cuts of tree when anew fileisimported (*.xml or *.dag)
Automatic cutting when deeper than : When automatic cutting, N is the number or doors after which the
link is cut.

Graphics tab enables to modify GUI look :

Use Windows look and feel : Use the look and feel of your operating system instead of java look and feel
(GRIF restart is needed).

Element Zoom : Changes graphics size.

Comment size : Changes comment font size.

Group size : Changes group font size

Activate cross hair : Activate cross hair which enables object alignment.

Activate smoothing for texts: Activate anti-aliasing (smoothing) for texts, it can slow the display.

Activate smoothing for images : Activate anti-aliasing (smoothing) for images, it can slow the display.
Activate tooltips: Activate tooltip-system.

Use gate symbol for automatic layout : Use only symbol of gates to center during auto-layout, and not the
total gate (the area dashed if selected).

Digital format tab enables to customize digits display :

Display of parameters: Specifies the display of parameters (number of digits, ...).

Events tab enables to change gates/reports display. :

Label size: Specifieslabel font size.

Display name : Enables to display name or not

Display description : Enablesto display description or not.

Display law : Enables to display law or not.

Display CCF : Enablesto display or not commons causes failures.

Display target value : Display the target value for each gate.

Additional information : Enablesto display additional information (results of computation)
Use a default law : Enablesto use a specific law as default law.

Default law : Enables to define the default law to be used.

Remark height : Height (in pixels) of the remark-frame at the top of events. Default valueis 40.
Remark width : Width (in pixels) of the remark-frame at the top of events. Default value is 100.

Gates/Shortcuts tab enables to change gates/reports display. :

Label size: Specifieslabel font size.
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» Display name: Enablesto display name or not

» Display description : Enablesto display description or not.

» Display K/N : Enablesto display K/N or not.

» Display shortcut location : Display the set of reports for a gate.

» Display target value: Display the target value for each gate.

» Additional information : Enablesto display additional information (results of computation)

» Display shortcut source name : Display name of the matching gate under identical transfer gate.
» Display shortcut source page : Display page of the matching gate under identical transfer gate.

* Remark height : Height (in pixels) of the remark-frame at the top of gates. Default value is 40.

* Remark width : Width (in pixels) of the remark-frame at the top of gates. Default valueis 100.

Charts tab enables to change charts drawing :

» Set graphicsborders: Add bordersto charts.

» Set generic values borders: Add borders to generic values under charts.
» Display grid : Display grid on curves area.

» Display legends: Display legends under curves.

» Drawing zone transparency : Activate curves area transparency.
» Graphic transparency : Activate charts transparency.

» Titlesize: Specifies chartstitle font size.

» Genericvaluessize: Specifies generic values font size.

» Paint size: Specifies point size on curves.

» Coordinates size : Specifies coordinates font size.

» Legend size: Specifieslegendsfont size.
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